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From the President
David Merkin, LLAGNY President 

 
Happy New Year 2005! 

Hard to believe it’s winter! 
Our energetic group of  Committee Chairs and Board Members have a lot planned for this year: 
New Features in Law Lines. 
Redesigned Website. 
New Union List. 
Educational  Programs on Finding US , Foreign and Multi-National Treaties and How to research 
and compile Legislative Histories. 
Bridge the Gap Program. 
LLAGNY Brochure. 
And together with SLA we are planning a Copyright Law Program. 
So please check the LLAGNY Website frequently and watch for mailings on all the upcoming exciting 
programs and changes. 
Lastly we are thinking of holding another LLAGNY TALENT SHOW. 
Depending on how many volunteers it will either be in June or in the Fall. So who out there is ready to 
perform? 
Please e mail me dmerkin@shearman.com or Janice Henderson  jhenderson@cov.com 
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Bite the Bullet 
Victoria J. Szymczak, Brooklyn Law School 

 
This is the first installment in an ongoing column dedicated to the eradication of bullet point lists in slide 
presentations.  While situations exist where the use of a bulleted list is an excellent choice,1 I often feel that there are 
more interesting and effective ways to grab the attention of my audience and still make my point by using other 
tools available in my software program.  An idea might be best represented by a simple graphic, or a layout that 
moves away from a rigid hierarchical system.  This is confirmed and reinforced often by the software trainer at my 
institution, Mr. Lloyd Carew-Reid.   
 
I am sure that many of you will agree, death by bullet points is not the way you want to go.  It is for this reason I 
created this column.  I am so annoyed by the overuse of bulleted lists, I started playing a game with myself when 
attending conferences, meetings, etc….  If someone has a unique way to present a list I take note of it; however, if 
the lecture was accompanied by a seemingly endless slide presentation stuffed with bulleted lists, I start to doodle in 
my notepad.  I try to create a representation of the targeted information that takes advantage of the graphical power 
inherent in slide presentation software. If I am successful, I get dessert that day! (continued on p.9) 
 
 

 
 
 
 
 
 

                                                 
1 For example, using a bulleted list to attack opposing counsel’s arguments in court one-by-one can be devastating when presented 
correctly.  See Chapter 7 in Deanne C. Siemer and Frank D. Rothschild, Argument Slides, Easy Tech Series, National Institute for Trial 
Advocacy, 2003. 

Law Lines is published four times per year by the Law Library Association of Greater New York (LLAGNY). 
Issues appear In Spring, Summer, Fall and Winter. 
A subscription to Law Lines is included in the payment of membership dues. 
For membership information, contact Paulette Toth, Kirland & Ellis, paulette_toth@ny.kirkland.com 
Contributions, comments or news items for Law Lines may be sent to James Murphy, Brooklyn Law School Library, 250 
Joralemon Street, Brooklyn, NY  11201, (718) 780-7544, jmurphy@brooklaw.edu 
All contributions submitted for publication are subject to editorial review and are published at editorial discretion. 
LLAGNY does not assume responsibility for the statements advanced by the contributors to Law Lines nor do the views 
expressed necessarily represent the views of LLAGNY or its members. 
Acceptance of advertising is not an endorsement of products or services of advertisers. 
 
Copyright 1998          ISSN 0148-0553 

LAW LINES EDITORIAL STAFF 
Jim Murphy, Editor (Articles)     Janet Peros, Technical Support 

Marlene C. Gebauer, Editor (Production)   Sarah Kagen, Technical Support 
Janet R. Pinkowitz, Proofreader 

♦Spring Issue    Article Submission Deadline♦ 
Spring 2005………………….…………………………….April 8th   

Please send in your suggestions for the next LLAGNY Profile (see p.5) to jim.murphy@brooklaw.edu 
Submissions should be in Word or WordPerfect.  Photos should be in JPG, TIF or GIF format. 



  

 



 ♦   

  

5

 

What about that Helen Lawless? 
Helen Lawless of Debevoise shares her take on Ashcroft and 
what she admires about librarians. 
 

Q:Who inspires you?  

It has to be the people I meet when I volunteer. Lately I’ve been working at a 
battered women’s shelter where I see people in the worst of circumstances 
shine. Their problems put my own in perspective. Before that I taught in a 
literacy program. There was one immigrant truck driver who memorized the 
map of Manhattan because he couldn’t read the street signs! 
 
What drives you to volunteer? 
 I’m a child of the 60’s- Civil Rights and the Viet Nam War- raised by parents 

to be involved- to be responsive to the larger community.  
 
What was your greatest challenge?  
When I was very young I lost the person that I loved. I think that a severe personal tragedy hits you harder when 
you’re young. Your emotions are closer to the edge. All that difficulty but without the network of friends who 
support you when you’re older.  
 
What’s your favorite time of day? 
Early morning, fresh and so full of possibilities. My bio clock is set for the morning too! That’s one reason I chose a 
schedule where my office day starts at 7AM. 
 
What do you do on your own downtime? 
I’m an avid gardener.  In the winter I read and plan my gardening adventures. The other three seasons finds me 
almost always in my garden. My other passion is travel.  Touring gardens, exploring different peoples and 
cultures…being a citizen of the world 
 
What did you want to be when you grew up? 
A cowgirl or a professor. 
 
Any advice for new law librarians? 
Learn as much as you can about everything! Don’t be reactive- just getting what a patron asks for. Be proactive- 
analyze what they really want. It’s our orientation to service that is our strength as librarians. 
 
What is the most exciting thing about your job? 
Debevoise has an enormous commitment to pro bono cases- death penalty, amnesty, evictions.  Recently we 
supported research for the prosecution in the trial of Milosevic at the Hague. 
 
About the profession? 
What I really admire about librarians is that despite our political differences, most librarians are First Amendment 
junkies. The flow of information should be free and open. Recently I read that the DOJ replied to a FOIA request 
for data surrounding the round-up of Muslims in the U.S. right after 9/11 by asking for over $100,000 in fees.  That 
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is tantamount to a denial, as most public interest groups cannot afford an amount that large.  When I heard 
Ashcroft mocking librarians for defending privacy, I was appalled.  I expect much better of my country.  It’s the 
library profession, and sometimes the judiciary that sometimes gives me hope. 
 
__________________________________________________________________________________________ 

Libraries and Librarians in Film Quiz 
Janet Peros, Bryan Cave LLP 

Look for answers on page 15. 
Please send any Library trivia you would like to see in Law Lines to janet.peros@bryancave.com. 

 
1. The character “Marian the Librarian” appears in what film? 
 
2. Parker Posey plays a party-hopping library clerk who goes on to library school in what 1995 film? 
 
3. In a recent film set in a small New Jersey town, a young, beautiful and blonde librarian kisses a dwarf played 

by Peter Dinklage at the train depot which plays an important role in this film. 
 
4. Rachel Weisz plays a fearless librarian companion to Brandon Frasier in this film. 
 
5. When Jimmy Stewart takes a look at what his life would be like if he’d never been born, he sees his wife 

would have turned out to be a lonely librarian with glasses and a bun (no stereotype there). This film is a 
holiday favorite. 

 
6. Katherine Hepburn plays head of reference in this film with Spencer Tracey as an efficiency expert. 
 
7. This film was based on a novel by Umberto Eco and stars Sean Connery as a monk investigating a murder 

in a 12th century monastic library in Northern Italy. 
 
8. In what many call the worst reference interview ever, a young polish immigrant asks for books on “the 

American poet Emil Dickens”.  The librarian is enraged that someone would think that Dickens was a poet, 
or worse yet, an American.  Not realizing she means Emily Dickenson, the librarian’s tirade causes the 
woman to faint.  The woman’s name is part of the title of this film. 

 
9. The card catalog is possessed, and the librarians are acting strange.  The old maid librarian with requisite 

bun is actually a ghost.  Name the film with Bill Murray. 
 
10.  Librarians are the only ones left in the world who can access information in 2022.  In this bleak futuristic 

tale, they also are the only ones that know the true source of the material named in the title of this film. 
 
11.  Richard Burton plays a former spy who works as a clerk in a library.  Claire Bloom is the librarian, who also 

happens to be a communist.  Name the film. 
 

12.  Ali McGraw is pursued by a librarian played by Richard Benjamin in this 1969 film. 
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Thomson West Holiday Party 
December 7, 2004 @Metrazur 

Photos by Marlene Gebauer & Janet Peros 
 

 
Bill Mills, NY Law School; Kathleen McLeod & Kit 
Kreilick, Fordham University Law School 
 

 
Janet Accardo, Skadden Arps Slate Meagher & Flom; 
Anne Ellis, Westlaw;  Carrie Hirtz, Skadden Arps Slate 
Meagher & Flom 

 
2004 Law Lines Staff:  Janet Peros, Bryan Cave; Susana 

Camargo-Pohl, Westlaw; Marlene Gebauer, Greenberg 
Traurig; James Murphy, Brooklyn Law School; Sarah  

Kagen, Sidley Austin Brown and Wood.  Not pictured:  
Janet Pinkowitz, Columbia University School of Law; 
Gianina Pascarui, Greenberg Traurig 
 

 
Gitelle Seer, Dewey Ballentine; Benjamin Toby, 
Freshfields Bruckhaus Deringer; Stephanie Fox-Pierson,  
Westlaw 
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Lexis Holiday Party, December 9, 2004 
@the Yale Club 

Photos by Janet Peros 
 

   
                          Nejat Bumin, Lisa Yee Piña,         Stephanie Roeth, Katherine Varoukas,  
             Cheryl Manganblln,, Shalonda Bayless-Owens,      Susan Lee, Abbey Gardy 
                                        Lexis-Nexis       
 
 

   
                      Gayle-Lynn Nelson, LexisNexis Jorge Concepcion, Bryan Cave Carol Barra,  LexisNexis 
                      Maria Maida, Proskauer Rose                 Raul Lopez, LexisNexis             Heidi-Marie Bliss,    
       Solomon  Crook, Bryan Cave O'Melvany & Myers 
            
 
 

   
                                LaTonya  Branch, Gary Brown,            Sarah Andeen, Jenifer Murray, 
                               Esther Vincenty,, DLA Piper Cary Gray       Greenberg Traurig 
                                John Fenimore, JP Morgan Chase       Keith James, Cindy Spohr, LexisNexis 
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Szymczak , continued from page 3 
 
Each issue of Law Lines will highlight an alternative way to present bulleted information.  If you have ideas on this 
topic, please feel free to email me to discuss your contribution to this vital issue.  Our aim is to assist law librarians 
who engage in public speaking and want to engage their audience as well. 
 
The first presentation do over represents relevant Library of Congress subject headings for researching Rule 11 of 
the Federal Rules of Civil Procedure.  If a bulleted list was used, the main headings would appear next to the bullet, 
and the subdivisions (such as the geographic heading) would appear indented below the main heading.  Below is a 
star burst graphic which presents the same information in a less linear format.   
 
The main headings are identified by spokes leading out from the star burst, while the subheadings of New York 
State and United States are floating between main headings.  I also suggest that the circular arrangement is better 
than a list since a hierarchical list might suggest to the audience that a heading appearing higher on the list will be 
more important to a researcher than one appearing on the bottom of the list.  In this instance, I did not want to 
convey that idea.  A graphic like this might also be used to represent the services your library provides to your 
patrons.  Since all of our services are important, you may not want to indicate that one service, one department, or 
one individual is needed more than others. 
 

 
 
This graphic is easily created using the drawing tools in your software.  In PowerPoint make sure the drawing 
toolbar is displayed in your software by going to Tools > Toolbar and checking off Drawing.2  Among the items 
displayed in the drawing toolbar is  AutoShapes.  To create the star burst, go to Autoshapes > Stars and Banners > 

                                                 
2 In Corel Presentations, go to View > Toolbars > select Tool Palette. 
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Explosion 1.  To make the ovals, go to Autoshapes > Basic Shapes > Oval.3  You have the option to fill the shapes 
with color or pattern styles, as well as having an outline of the shape appear in a different color.  Color and line 
features are available on your drawing tool bar.  In this example, I used light and medium blue fill with a gradient fill 
effect and thin white outlines on the shapes. 
 
To create the spokes, go to Autoshapes > Lines > Line.4  You might want to increase the thickness of the lines by 
selecting Line Style off of the drawing toolbar and then selecting the desired thickness for your spoke.  In this 
example, I used 2 ¼ pt  white lines.  Note that the line must be selected with your cursor in order to thicken the line 
or select the color.   
 
The text can be inserted into the shapes by going to Insert > Text Box, and then dragging your cursor across the 
targeted shape to create the box.  Once the box is drawn over the shape, you can type your text.  Color, size, fill and 
font style for the shapes and the text are up to you.  Your decision depends a lot upon the slide background in 
addition to your taste in colors.  For the text here, I used a bolded white 24 pt Ariel font in the ovals and a 28 pt 
font in the star burst (explosion). Note that the background for this slide was a dark blue. 
Vicki Szymczak can be contacted at victoria.szymczak@brooklaw.edu.   

Serving NY, NJ, & CT since 1977 

Sofia Empel, MLS                                                                                        Lucy Rieger, MLS 

Our services include:  

 
o Looseleaf Filing/ Maintenance 
o Archive/ Document Management                                            
o Space Planning/ Moving        
o Permanent or Temporary 

332 Terrace Avenue, Hasbrouck Heights, New Jersey 07604 
 

                   (201) 288-5883 *Luiny@Libraryupdate.com * FAX (201) 288-7976           

 
                                                 
3 In Corel Presentations the star shape can be drawn by going to Star Shapes > Explosion 2.  The oval shapes can be created by going to 
Basic Shapes > Draw and ellipse.   
4 In Corel Presentations, lines can be drawn by going to Line Shapes > Draw a line. You can control the thickness of the line by selecting 
Line Width which is also on the toolbar. 
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MEMBERSHIP NEWS & MOVES 
Recent Member changes: 
 
Allison Aridas is Reference Librarian at 
Willkie Farr & Gallagher LLP. 
 
Stephanie Brock is Reference Assistant at 
Debevoise & Plimpton. 
 
Janeen Byron is at Wachtell Lipton Rosen 
& Katz. 
 
Elena Carasca is an MLS student at Queens 
College. 
 
Jeffrey Cohan is at McElroy, Deutch, 
Mulvaney & Carpenter which was formerly 
Carpenter, Bennett & Morrissey. 
 
Joanne Devaney is Reference Librarian at 
ASRC Aerospace/ EPA Region 2 Library. 
 
Elizabeth Gooch is Director of Operations 
at Quinn Emanuel. 
 
Barrett Graham is now Systems Librarian at 
Dechert LLP. 
 
Joseph McDonnell is Director of Support 
Services at Kasowitz Benson Torres & 
Friedman. 
 
Eytan Moked is Reference Librarian at 
Greenberg Traurig LLP. 
 
 
 
 
 
 
 

 
Sara Paul, formerly with O’Melveny & 
Myers LLP, is now Reference Librarian with 
the District Attorney’s Office, NY County. 
 
Megan Scanlon, formerly with Greenberg 
Traurig LLP is now Reference Librarian at 
Nixon Peabody LLP. 
 
Shiela Sterling is now New York Library 
Manager at Greenberg Traurig LLP. 
 
Teresa Tully formerly at Sidley Austin 
Brown & Wood LLP is now Corporate 
Librarian at Debevoise & Plimpton. 
 
Carol Turner is Administrator at 
Constantine & Partners. 
 
Recent Law Firm Changes: 
 
Baker & McKenzie is now Baker & 
McKenzie LLP. 
 
Kirkpatrick & Lockhart LLP is now 
Kirkpatrick & Lockhart Nicholson Graham 
LLP 
 
Morrison Cohen LLP is now located at 
 909 Third Ave, 27th Floor,  
New York, NY 10022-4731 
 
Piper Rudnick LLP is now DLA Piper 
Rudnick Gray Cray US LLP 
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LLAGNY Annual Meeting & Post Holiday Party 
Thursday, January 6th 
@ the Manhattan Club 
Photos by Marlene Gebauer 

 

    
                            Karen Provost, Mayer Brown & Platt,   Jim Roscher, independent, 

          Ben Toby, Freshfields, Bruckhaus & Deringer    Joel Solomon, Windels Marx Lane & Mittendorf 
            
 

 
John Fitzgerald, Kirkland & Ellis, Dan Labor, Institutional Investor, 
Fred Shanks, Sherman & Sterling, Paulette Toth, Kirkland & Ellis, 

Edmund Dawson, Cravath, Swaine & Moore 
 
 

    
 
                            Raphael Sanchez, Cronish Lieb,    Karen Huesel, Linda Wood, Carol Sergis, 
                        Heather Stribel, Curtis Mallet-Prevost, Colt & Mosle  Jeffery Giles, Schulte Roth & Zabel 
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LLAGNY Board Meeting 
November 17th, 2004 

Stroock & Stroock & Lavan LLP 
New York, NY 10038-4925 

 
Members Present:  David Merkin (presiding), Patricia 
Barbone, June Berger, Heidi Bliss, Anthony Cocuzzi, 
Karen Heusel, Patricia Kasting, Janet Peros, Andrew 
Tschinkel, Mark Zalek 
 
Board Meeting Called to Order:  6:07 PM 

 Approval of October 27th, 2004 minutes 
 Minutes approved as corrected (Berger, Bliss) 

 
Treasurer’s Report: November 17th, 2004 

• The balance of the checkbook as of 
November 17, 2004 is $42,855.91 

• The balance of the money market fund is 
$75,539.89 as of the September 14th, 2004 
statement. 

• The value of our 60 month CD maturing  
8/20/09 is $10,059.39 

• Our expenses from September 23rd, 2004 to 
November 15th, 2004 consisted of 

o $330.99            Bank fees, and 
reimbursements for Leadership 
meeting 

o $243.09            Postage for Tax 
Education program mailing 

o $1,694.50         AALL Membership 
Invoices and annual maintenance fee 
of $600 

o $9,000             New Members 
Reception 

o $60                  NYS Charity Filing Fee 
o $71                  Stationery, 

miscellaneous Label expenses 
• Our total expenses were $11,399.58 
• Our income from September 23rd, 2004 to 

November 15th, 2004 
• consisted of   

o $1,183.32       Board related income 
including reimbursements, Dialog 
check, and previously                                                                                                  
unapplied payment from West 
Thomson.  

o $570            Grants & Scholarships 

o $750            Job Placement 
o $375            Law Lines Advertising  
o $5,000         Membership 
o $3,000         New Members Reception 

(financial support from Lexis) 
• Our total income is $10,878.32 
• Our tax filings to the IRS and to the NYS 

Bureau of Charities have been completed and 
mailed.  LLAGNY owed no state or federal 
tax. 

• The end of year Treasurer's Report has been 
audited by our Accountant and the final 
version is being distributed at tonight's 
meeting, November 18th, 2004.  A copy of 
the Report and complete Ledger for FYE 
6/30/2004 is also being distributed to H. Bliss 
and D. Merkin. 

• Chapter Insurance, was paid.  
• Fall Soiree. Net cost was $6000, ($9,000 for 

Planet Hollywood less $3000 of support from 
Lexis)  The total event cost was less than the 
prior two years thus the Special Events 
Committee was successful in achieving the 
Board's objective of lowering event expenses.   

• Advertising  revenue is beginning to trickle in.  
A full accounting from the committee is 
expected shortly. 

 
Old Business: 

• Union List:  Task:  Contact EOS and ask 
them we can set up an Internet demonstration 
of the product. 

• Stationary:  Colors of logo is not yet 
determined.  

• Task:  Board is to compare Fall Soiree flyer 
colors to Law Lines colors. 

 
New Business:  

• Dialog Quantum Session Dates:  Recommend 
that this program be held as a morning or 
lunch program in January at Westlaw 
headquarters. 

 
Committee Reports: 

• Corporate Sponsorship:   
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o Committee is still seeking corporate 
sponsorship support for the Holiday 
Party. 

• Education Committee: 
o Flyers should use a proper copy of the 

new logo. 
o Repeat popular programs either 

downtown or uptown depending on 
the location first presented, i.e. if held 
downtown repeat program uptown. 

• Law Lines should be out by the end of the 
month and will contain some new features 
(i.e.-member profiles). 

• MCLE/Teaching Legal Research Committee:   
o The Diamond Law Library of 

Columbia University Law School has 
been secured as the host location for 
the Spring 2005 Bridge the Gap 
program.  The program is scheduled 
for April, 2005. 

o Reviewed and recommended changes 
to the proposed law firm sponsorship 
flyer for the Bridge the Gap program.  
Committee is to resubmit modified 
flyer for the next Board meeting. 

o David Merkin offered the services of 
Shearman & Sterling when this 
committee needs to make a mass 
mailing. 

o Task:  Email copy of previous budget 
to the Board. 

• Membership Committee:   
o Membership Committee:  The committee 

is working on proofing the directory.  
They want to know what our policy 
should be about refunding membership 
dues to people who claim they've left the 
profession (within a few months of 
renewing). 

o The forthcoming LLAGNY Directory will 
use the new logo on the cover.  Cover will 
be in of an orange/gold. 

o Task:  Heidi will email a copy of the 
welcome letter to new members to the 
Board. 

 Motion:  Will not refund membership dues of 
members who leave the profession. 

o Motion Approved (Bliss, Barbone) 

• Public Relations committee: 
o Task:  Post the brochure promoting 

LLAGNY to the LLAGNY website. 
• Special Events Committee: 

o Motion:  The Annual Winter Meeting & 
Post Holiday Party will be held Thursday, 
January 6th, 2005 at the Manhattan Club. 

o Motion Approved (Bliss, Barbone) 
o Task:  Secure the NYC Bar Association 

location for the 2005 Fall Soiree. 
• Volunteer Committee: 

o Revised the volunteer form that was 
discussed at the last Board meeting.  They 
would like to post on the LLAGNY Web 
site.  Revised form submitted.  

o Recommend that line for email be added. 
o Board asks if the form can be made 

interactive with an automatic response 
when form is submitted. 

o Electronic submissions may go to a 
Yahoo account that is regularly checked 
by the Volunteers committee.  The 
committee would then route submissions 
to the appropriate committee chairs. 

o Other committees needing help on 
specific activities should contact the 
Volunteers committee and post their 
request for assistance on the LLAGNY 
listserve. 

o Task:  Post committee descriptions from 
the Leadership Manual to the LLAGNY 
website. 

 
Meeting Adjourned:  7:55 PM 
Respectfully submitted, 
Patricia Kasting 
Secretary LLAGNY 
 
Thursday, December 9, 2004 
Members Present (Lexis event) Heidi Bliss, Karen 
Heusel, David Merkin, Mark Zaleck, Andrew 
Tschinkel, and  Janet Peros.  
It was agreed that the price of the Holiday event 
would be $50.  Language regarding sponsorship 
(flyer) should be changed to Co-Sponsored as there is 
more than one corporate sponsor 
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LLAGNY BOARD MEETING 

December 10, 2004 
Teleconference Call 

 
Members Present:  David Merkin (presiding), Patricia 
Barbone, Heidi Bliss, Anthony Cocuzzi, Patricia 
Kasting, Janet Peros, Andrew Tschinkel, Mark 
Zaleck. 
 
Board Meeting called to order:  10:05 AM 
Approval of November 2004 minutes: 

o Motion to approve with clarification 
o Minutes approved as clarified (Bliss, Barbone) 

 
Treasurer’s Report: 
 
Old Business: 

o Stationary Colors:  Selected version identified 
as LLAGNY 1. 

o Union List:  Karen Campbell and her board 
liaison will coordinate Internet 

demonstrations of the systems proposed by 
EOS and SIMA. 

 
New Business: 

o Joint LLAGNY and SLA program scheduled 
for March 23, 2005.  Speaker fees and other 
expenses are divided between LLAGNY and 
SLA.  Speakers and 2 sponsors are secured.   

 
o Task:  David will confirm arrangement 

with speaker. 
 
Committee Reports: 

o Advertising Committee:  Need to remind 
vendors that monies paid to LLAGNY are to 
identify purpose of payment and advertising 
rate. 

o Membership Committee:  Directory is slow to 
proof. 

o Task:  David will ask for volunteers. 
o Technology Committee:  The LLAGNY 

website is under revision.  LLAGNY 
members have asked that a member search 
will identify member’s firm. 

Task:  Mark will talk to Stanley about this function.
 
__________________________________________________________________________________________ 
Answers to Libraries and Librarians in Film Quiz 
on page 6: 
 

1. Music Man 
2. Party Girl 
3. Station Agent 
4. Mummy 
5. It’s a Wonderful Life 
6. Desk Set 
7. Name of the Rose 
8. Sophie’s Choice 
9. Ghostbusters 
10. Soylent Green 
11. The Spy Who Came in From the Cold 
12. Goodbye, Columbus 

 
 
 
 

WONTAWK 
 

Outstanding Recruitment for Librarians & Other 
Information Professionals – Coast to Coast 

Permanent & Temporary 
Candidates Include Legal, Business & Finance Researchers 

Professional – ParaProfessional – Clerical 
Contact: Sarah Warner - Director of Staffing Services 

Phone-212/869-3348 - Fax-212/997-1127 
www.wontawk.com   wontawk@msn.com 

Call WONTAWK! 
       Get the EDGE in Staffing and Consulting Services! 
 

 



 ♦   

  

16

 

  

 
 
 
 
The LLAGNY Education 
Committee presents: 
 
Online Access to Government     
Information: Getting 
Government Documents to 
your Desktop 
 
Thursday, April 7, 2005 from 
9:30 am to 11:30 am 
 
Fordham Law School 
140 W. 62nd Street 
New York, NY 10022-6069 
(Bring photo ID)  
 
Continental breakfast will be provided. 
 
There is no charge for this program but 
you must register by March 31, 2005. 
Space is limited to 75 attendees. 
 
To register, contact:  
Norma Feld 
feld@yu.edu 
212-790-0219 
212-790-0236 (fax) 
 
 

 
 
 
Finding Government Documents Efficiently and Cost 
Effectively 
 
Law Librarians are often faced with the need of quickly 
putting their hands on all manner of government 
information quickly, efficiently and cost effectively.  The 
proliferation of government material available online – and 
for free – makes that task easier than ever.  
  
This program will guide the professional through the maze 
of online resources and along the many paths to access. 
 

• Discover the variety and extent of            
      information provided for free by the    
      executive, legislative, and  judicial 
      branches of the federal government as   

            well as independent agencies. 
 

• Learn how to access this ever-growing stockpile of 
free government information using databases, 
portals, search engines, and other finding aids. 
 

• Learn how to track and stay up to date with 
legislative and administrative agency 
developments. 

 
• Hear about the federal government’s ongoing 

digitization and preservation plans and its efforts 
involving document authentication. 

 
Presenters:  
 
Jane A. Cramer, Government and Legal Information 
Librarian, Brooklyn College Library 
 
Michael H. Roffer, Government Resources and 
Reference Librarian, New York Law School Mendik 
Library 
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RESEARCH & RETRIEVAL 

WORLDWIDE 
LEGAL ~ FINANCIAL ~ GOVERNMENTAL ~ 

SCIENTIFIC 
 

  Client Comments: “I have a miracle retrieval service I 
use: Cal Info.” 
   “Not only did I get [the documents] yesterday…before 
my two hour 
    deadline [but you] called to make sure I was receiving 
them.”  
   “It seems like things arrive almost as soon as I get off 
the phone.”  

 
PUBLISHERS OF: CAL INFO GUIDE TO ADMINISTRATIVE 

REGULATIONS OF THE STATES & TERRITORIES, 13TH ED. 
 

4750 41ST Street, NW, Suite 5, 
Washington, DC 20016 

Phone:  202-537-8901   Fax:  202-537-
8902 

 
316 West Second Street, Suite 1102, Los 

Angeles, CA 90012 
Phone:  213-687-8710   Fax:  213-687-

8778 
www.calinfo.net 
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Things are Bigger in Texas  
By Monica M. Ortale, M.L.I.M., J.D.  
Faculty Services & Reference Librarian  
The Fred Parks Law Library, South Texas College of Law 
   

"Things are Bigger in Texas!" Just take a look at the giant sized boots outside North Star Mall. A tribute to just two 
of my not so secret vices, shopping and shoes!  San Antonio has fabulous shopping, and La Villita is next to the 
Hilton, a complex of 27 restored buildings on the site of a Coahuiltecan Indian Village. Each building showcases 
various artists. There's painting, jewelry, pottery and beautiful weavings, all unique to the region. 
  
Just a short trolley ride down Commerce St. is El Mercado, a veritable warehouse of pottery, and then there's the 
farmer's market. If you don't get enough to eat browsing the stalls, then head to the restaurants. La Margarita is my 
favorite, and I can picture it now as the colorful waiter carries the sizzling fajitas platter, the steam streaming behind 
and, oh, the aroma! 
  
But, for those with a car, head north on I-35 for about 30 minutes and be prepared to visit the mecca of all 
shopping. The factory outlet stores of San Marcos, hundreds of them, too many to mention, but definitely worth 
the trip when you consider the savings. 
  
Ah, but I digress. For those who love shopping for footwear, there are marvelous bootmakers.  Try Lucchese, hand 
made bootmakers since 1883, or Crazy Horse custom boots, both in San Antonio. 
  
For me, shoes are everything, and the factory outlet shoe stores are an option. But, if you want something closer to 
the convention center, then Dillards & the shops in RiverCenter have a wonderful assortment. When all are tried 
on and bought, there's nothing like relaxing at a table on the Riverwalk level, watching the tourists and the 
riverboats, sipping a Starbucks coffee, knowing that the bags surrounding you are full of shoes just waiting for the 
right occasion, like, the General Business meeting 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LLAGNY JOB POSTINGS 
 

Advertise your current job postings on the LLAGNY website. 
 

http://www.aallnet.org/chapter/llagny/jobs.html 
 

Rates are $50 for two weeks, $75 for four weeks.  Check should be made payable to 
LLAGNY.  Send job descriptions to Denis O’Conner via email or fax.  Please include your 
name, address and telephone number for billing purposes.  Job descriptions received by 

Thursday at 4pm are normally posted on this Web page the following Monday. 
 

Denis O’Conner 
Debevoise & Plimpton 

919 Third Avenue 
New York, NY  10022 

Fax: 212-909-1025 
droconner@debevoise.com 
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VOLUNTEER FORM 

 
 The success of LLAGNY is dependent on the voluntary efforts of it’s members.  By joining a committee, 
you have the opportunity to interact with your colleagues, make a contribution to your professional association 
and see the results of your efforts. 
 
 This is the chance to build on old experiences and contribute your expertise and background.  The more 
people who come forward, the more the work is shared. 
 
 Below is a list of committees which cover a wide range of functions and activities.  Please click on the 
committee name for a detailed description of each.  Please feel free to contact the committee co-chairs for any 
questions on their specific committee. 
 
Advertising | Corp. Sponsorship | Education | Govt. Relations | Grants/Scholarships.  
Job Hotline | Law Lines | MCLE | Membership | Nominations  
Placement | Pro Bono | Public Relations | Special Events  
Student Relations | Technology | Union List | Volunteers 
 

Name:_______________________________________________________ 
 
Title:________________________________________________________ 
 
Affiliation:____________________________________________________ 
 
Phone:________________________ Email:__________________________ 
 
1st choice_____________________ 
2nd choice_____________________ 
3rd choice_____________________ 
 
________Please assign me to any committee    
 

Please  email your completed form to the Membership Committee John Davey Co-Chair daveyj@sullcrom.com or 
Brooke Raymond braymond@goodwinprocter.com 

mailto:braymond@goodwinprocter.com
mailto:daveyj@sullcrom.com
http://www.aallnet.org/chapter/llagny/Volunteers.html
http://www.aallnet.org/chapter/llagny/UnionList.html
http://www.aallnet.org/chapter/llagny/Technology.html
http://www.aallnet.org/chapter/llagny/StudentRelations.html
http://www.aallnet.org/chapter/llagny/SpecialEvents.html
http://www.aallnet.org/chapter/llagny/PublicRelations.html
http://www.aallnet.org/chapter/llagny/ProBonoComm.html
http://www.aallnet.org/chapter/llagny/Placement.html
http://www.aallnet.org/chapter/llagny/Nominations.html
http://www.aallnet.org/chapter/llagny/Membership.html
http://www.aallnet.org/chapter/llagny/MCLE.html
http://www.aallnet.org/chapter/llagny/LawLinesComm.html
http://www.aallnet.org/chapter/llagny/GrantsScholarships.html
http://www.aallnet.org/chapter/llagny/GovtRelations.html
http://www.aallnet.org/chapter/llagny/Education.html
http://www.aallnet.org/chapter/llagny/CorpSponsorship.html
http://www.aallnet.org/chapter/llagny/Advertising.html


◊  BOARD OF DIRECTORS 2004-2005  ◊ 
PRESIDENT 
David Merkin 

Shearman & Sterling 
599 Lexington Ave 

New York, NY 10022 
(212) 848-4627 ● (212) 848-5229 (fax) 

dmerkin@shearman.com 

EX-OFFICIO: FINANCIAL ADVISOR 
Nancy Rine 

Fried Frank Harris Shriver & Jacobson 
One New York Plaza 
New York, NY  10004 

(212) 859-8901 ●(212) 859-8586 (fax) 
rinena@ffhsj.com 

VICE PRESIDENT/PRESIDENT 
ELECT 

Heidi-Marie Bliss 
O’Melveny & Myers LLP 

Times Square Tower  
7 Times Square  

New York, NY 10036 
(212) 326-2020)●(212) 326-2061(fax) 

HBliss@OMM.com 

IMMEDIATE PAST 
PRESIDENT 

June Berger 
Strook & Strook & Lavan 

180 Maiden Lane 
New York, NY 10038 

(212) 806-5701 ●(212) 806-6006 
(fax) 

jberger@strook.com 

SECRETARY 
Patricia Kasting 

Hofstra University Law School 
122 Hofstra University 
Hempstead, NY 11549 

(516) 463-5905 ●(516) 463-5129 (fax) 
lawpak@mail1.hofstra.edu 

TREASURER 
Patricia Barbone 
Hughes Hubbard 

One Battery Park Plaza 
New York, NY 10004 

(212) 837-6594 ●(212) 422-4726 
(fax) 

barbone@hugheshubbard.com 

BOARD MEMBER (Two Years) 
Anthony Cocuzzi (2004-2006) 

Milberg Weiss Bershad Hynes & Lerach LLP 
One Pennsylvania Plaza 
New York, NY 10119 

(212) 594-53007●(212)868-1229 (fax) 
acocuzzi@milbergweiss.com 

BOARD MEMBER (Two Years)
Karen Heusel (2003-2005) 
Schulte Roth & Zabel LLP 

919 Third Ave 
New York, NY 10022 

(212) 756-2303●(212) 756-2303 
(fax) 

kheusel@srz.com 

BOARD MEMBER (Two Years) 
Andrew Tschinkel (2003-2005) 
New York State Supreme Court 

88-11 Sutphin Blvd 
Jamaica, NY   11435 

(718) 520-3140●(718) 520-3589 
(fax) 

atschink@courts.state.ny.us 

BOARD MEMBER 
(Two Years) 

Mark Zalek (2004-2006) 
Davis Polk & Wardwell 

450 Lexington Ave 
New York, NY 10017 

(212) 450-5853●(212) 450-
5522 (fax) 

mzalek@dpw.com 

BOARD MEMBER (One Year) 
Janet Peros (2004-2005) 

Bryan Cave LLP 
1290 Avenue of the Americas 

(212) 541-2168●(212) 541-4630 
(fax) 

janet.peros@bryancave.com 

◊  COMMITTEE CHAIRPERSONS 2004-2005  ◊ 
ADVERTISING 

Elizabeth Kenney, Co-Chair 
Proskauer Rose LLP 

1585 Broadway 
New York, NY 10036 

( 212)969-5007●(212)  969-2931 (fax) 
ekenney@proskauer.com 

GRANTS/SCHOLARSHIP 
Bruce Bosso Co-Chair 

New York State Appellate Division (2nd Dept) 
45 Monroe Place 

Brooklyn, NY 11201 
(718) 722-6356 ● (718) 722-6302 (fax) 

bbosso@nysad2d.org 

MEMBERSHIP (con’t) 
Brooke Raymond , Co-Chair 

Goodwin Procter LLP 
599 Lexington Ave 

New York , NY 10022 
(212) 459-7463 

braymond@goodwinprocter.com 
 

STUDENT RELATIONS  
Kim Council, Co-Chair 

Sullivan & Cromwell LLP 
125 Broad St. 

New York , NY 10004 
(212) 558-3780●(212) 558-3346  (fax) 

councilk@sullcrom.com 

Wilson Addo, Co-Chair 
Davis & Gilbert LLP 

1740 Broadway 
New York , NY 10019 

(212)  468-4836●(212) 468-4888 (fax) 
waddo@dglaw.com 

Helen M Lawless Co-Chair 
Debevoise & Plimpton 

875 Third Ave 
New York, NY 10022 

(212) 909-6987 ● (212) 909-1025 (fax) 
hmlawless@debevoise.com 

NOMINATIONS 
OPEN 

Ralph Caiazzo, Co-Chair 
New York Law Institute 

120 Broadway, Room 932 
New York, NY 10271 

(212) 732-8720●(212) 406-1204 (fax) 
ralph@nyli.org 

CORPORATE SPONSORSHIP 
Elaine Egan, Co - Chair 

Epstein Becker & Green ,PC 
250 Park Ave 

New York , NY 10177 
(212) 351-4571●(212) 661-0989 (fax) 

Elaine.egan@ebglaw.com 

LAW LINES 
James Murphy Co-Chair 

Brooklyn Law School 
250 Joralemon Street 
Brooklyn, NY 11201 

(718) 780-7544 ● (718) 780-0369 (fax) 
jmurphy@brooklaw.edu 

PLACEMENT  
Dennis O’Connor 

Debevoise & Plimpton 
875 Third Ave 

New York, NY 10022 
(212) 909-6278 ● (212) 909-1025 (fax) 

droconnor@debevoise.com 

TECHNOLOGY 
Stanley Conrad, Co-Chair 

St. John's University School of Law 
Rittenberg Law Library 
8000 Utopia Parkway 
Jamaica, NY 11439 

(718) 990-2012●(718) 990-6649 (fax) 
conrads@stjohns.edu 

Janet Accardo, Co-Chair 
Skadden Arps Slate Meagher & Flom LLP 

Four Times Square  
New York , NY 10036 

(212) 735-2345●(212) 735-2000 (fax) 
jaccardo@skadden.com 

Marlene Gebauer, Co-Chair 
Greenberg Traurig , LLP 

885 Third Ave. 
New York, NY  10022 

(212)-801-2169●(212)-688-2449 (fax) 
gebauerm@gtlaw.com 

PRO BONO 
Kathryn McRae, Co-Chair 

Hawkins , Delafield & Wood 
67 Wall Street 

New York, NY  10005 
(212) 820-9447●(212) 344-6258 (fax) 

kbmcrae@hdw.com 

Benjamin A. Toby, Co-Chair 
Freshfields Bruckhaus Deringer LLP 

520 Madison Avenue 
New York, NY 10022 

(212) 277-4084●(212) 277-4001 (fax) 
benjamin.toby@freshfields.com 

EDUCATION  
Kathleen A. McLeod, Co-Chair 

Fordham University Law Library 
140 W. 62nd Street 

New York, NY 10023 
(212) 636-7698●(212) 6367357 (fax)  

kmcleod@law.fordham.edu 

MCLE  
Sarah Valentine, Co-Chair 

New York Law School Library 
57 Worth Street 

New York , NY 10013 
(212) 431-2385●(212) 965-8839 (fax) 

svalentine@nyls.edu 

Anthony Lovell, Co-Chair 
Sonnenschein Nath & Rosenthal 

1221 Avenue of the Americas 
New York , NY 10020 

(212) 768-6700●(212) 768-6800 (fax)  
alovell@sonnenschein.com 

UNION LIST  
Karen Campbell, Co-Chair 
Bingham McCutchen LLP 

399 Park Avenue 
New York, NY 10022 

(212) 705-7808●(212) 752-5378 (fax) 
karen.campbell@bingham.com 

Tom Eikenbrod , Co-Chair 
Shearman & Sterling LLP 

599 Lexington Ave 
New York , NY 10022 

 (212) 848 – 7576●(212) 848-5229 (fax) 
teikenbrod@shearman.com 

Jeff Cohan , Co-Chair 
Carpenter , Bennett & Morrissey 

Three Gateway Center 
100 Mulberry St. 

Newark , NJ 07102 
 (973)622-7711 ext 2300●(973) 622-5314 (fax) 

jpc@carpben.com 

PUBLIC RELATIONS 
John Lai,  

Shearman & Sterling LLP 
599 Lexington Ave 

New York, NY 10022 
(212) 848- 4627●(212) 848- 5229 (fax) 

jlai@Shearman.com 

Sarah Kagen, Co-Chair 
Proskauer Rose LLP 

1585 Broadway 
New York NY 10036 

(212) 969-5019●(212) 969-2931 (fax) 
skagen@proskauer.com 

GOVERNMENT RELATIONS  
Laird Ehlert 

New York Legislative Service Inc. 
299 Broadway 

New York, NY  10007 
(212) 962-2826 ● (212) 962-1420 (fax) 

nylegal@nyls.org 

MEMBERSHIP 
John Davey, Co-Chair 

Sullivan & Cromwell LLP 
125 Broad St 

New York, NY  10004 
(212) 558-4000●(212) 558-3346 (fax) 

daveyj@sullcrom.com 

SPECIAL EVENTS 
Judy Dhanraj, Co-Chair 

Stroock & Stroock & Lavan,LLP 
180 Maiden Lane 

New York, NY 10038 
(212) 806-5704●(212) 806-6006 (fax) 

jdhanraj@stroock.com 

VOLUNTEERS  
John C. Campbell, Co-Chair 

Nixon Peabody LLP 
437 Madison Avenue 
New York, NY 10022 

(212) 940-3132●(718) 889-9258 (fax)  
jccampbell@nixonpeabody.com 

  Karen Provost, Co-Chair 
Mayer, Brown, Rowe & Maw LLP 

1675 Broadway 
New York, NY 10019 

(212) 506-2724●(212) 262-1910 (fax) 
kprovost@mayerbrown.com 

Raul Lopez, Co-Chair 
LexiNexis 

125 Park Ave. S. 
New York NY 10017 

(212) 370-7422●(212) 309-8187 (fax) 
raul.lopez@lexisnexis.com 
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